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ABSTRACT: The eternal need of every human being in this world is oxygen. Plants play a vital role in maintaining 
the carbon  dioxide  and  oxygen  content  in  the  air.  Number  of plants are being destroyed each and every day for 
urbanization process. The number of plantings made is also reduced. Apart from these things more plants die due to 
lack of maintenance. IoT allows objects to be sensed and controlled remotely across existing network infrastructure, 
creating opportunities for more direct integration between the physical world and computer – based 
systems , and resulting in improved efficiency , accuracy and economic benefit. As water supplies 
become scarce and polluted, there is an urgent need to irrigate more  efficiently  in  order  to  optimize  water  use  to  
support  green environment. The sensors gather and analyse data about changing weather, soil moisture, humidity 
conditions. 
 
The main aim of this project is to maintain the nature of the plants by continuously monitoring the parameters leading 
to the increased life of both plants and human beings. The automatic systems are preferred to a manual system. 
 
KEYWORDS: IoT; smart ; garden; 
 

I.INTRODUCTION 
 
Automation rules the world nowadays. It is a technique of using computers or mobile phones in monitoring and 
controlling the simple parameters of day to day life. The standard of our life will be nourished by the practice of using 
automation for simple things. Using the concept of IOT we make sensors to communicate with each other which are 
powerful in automation. The important aspect of this prototype is that it saves cost and ensures safety. When people try 
to make plantings and set up their own garden, they were cautious in maintenance at only in their beginning stages. As 
days go on due to lack of maintenance the plants get destroyed. The Internet of Things can offer a feasible solution to 
this. The garden can be modernized with electronic technology that continuously monitors the conditions of plants and 
soil, so the plants could be provided watering and shade as required. All of this can be controlled and monitored online 
with the application of IoT. 
 
In this project, the sensors measure the moisture in the soil and the temperature, and automatically controls the water 
flow to the garden. People often grow unsuitable plants in their gardens so that they usually die from the lack of enough 
water, or even too much sunlight. In this project we use the sensors to obtain the values of the parameters and process 
them using microcontroller and control the survival of plants in the garden. Based on the soil type and plant type, the 
water requirement for the plant is defined. The user is also alerted periodically about the plants’ conditions. 
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1.1 INTERNET OF THINGS (IoT) 
 
Internet of Things (IoT) is an ecosystem of connected physical objects that are accessible through the internet. It is a 
system of interrelated computing devices, mechanical and digital machines, objects or people that are provided with 
unique identifiers and the ability to transfer data over a network without requiring human-to-human or human-to-
computer interaction. It includes traditional computing devices such as laptops, tablets and smartphones, but also 
includes a growing list of other devices that have recently become internet enabled. Examples include home appliances, 
automobiles, wearable electronics, security cameras and many other things. In order for a device to be part of the 
Internet of Things, it must be able to communicate with other devices. Therefore, it requires some type of built-in wired 
or wireless communication. Most IoT devices are Wi-Fi enabled, but Bluetooth can also be used to transfer data to 
nearby devices. IoT devices are commonly called “smart devices”, since they are able to communicate with other 
things. Along with the capacity to communicate, many IoT devices also include an array of sensors that provide useful 
information. While the Internet of Things is still in its infancy, it provides promising opportunities for the future. In 
time, the Internet of Things will become less of an abstract idea and more of a way of life. 
 
1.2 IMPORTANCE OF IoT 
 
1.2.1 Communication: 
 
IoT system increases and encourages machine to machine communication (also known as M2M). Because of this 
ingenious innovation, physical devices stay in touch with one another leading to greater efficiency and higher quality. It 
also allows full transparency. 
 
1.2.2 Automated: 
 
Due to the overall wireless infrastructure of these smart devices, it requires little to no human intervention, being able 
to pretty much operate on their own. This allows for greater control and automation leading to more operating 
efficiency. 
 
1.2.3 Information: 
 
IoT systems have allowed a greater flow of information which in turn allows people to make better decisions. It can be 
as simple as informing you that you are out of groceries to more complicated decisions at work. As people say 
knowledge is power! The systematic use of information also allows you to save time and work in an effective manner. 
 
1.2.4 Money: 
 
IoT systems thrive on efficiency thus, when machines communicate with each other, not only does it save time but also 
money and resources. For instance, your oven or kitchen electronic gadgets now have the ability to turn off themselves 
once the work is done. This makes the IoT system more environmental friendly as the system operates on minimum 
resources. Another way which this system saves money as it immediately informs its owner of any breakdowns or other 
technical problems with the system or anything else in the work or home environment. Hence, this immediate 
correspondence helps save time and money. 
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1.2.5 Use of IoT in different systems: 
 
Using IoT in systems such as healthcare or security can generate excellent results. For instance, by implementing chips 
in patients, doctors can monitor their patient’s vital signs and respond immediately in case of an emergency. Moreover, 
it can increase monitoring patients at homes, allowing for more free space in hospitals for serious cases. In case of 
security, police can use the IoT system to monitor the street cameras and improve the law and order. 
 
1.2.6 IoT systems in businesses: 
 
IoT systems would prove to be extremely advantageous for businesses; it would allow them to monitor consumer 
trends and respond to the demand changes in a timely manner. This could lead to greater sales which lead to greater 
profits and revenues. 
 
1.3 Applications: 
 
1.3.1 Wearables: 
 
Wearable technology is a hallmark of IoT applications and probably is one of the earliest industries to have deployed 
the IoT at its service. Fit Bits, heart rate monitors and smart watches are the most commonly used wearable these days. 
Wearables includes the Guardian glucose monitoring device. The device is developed to aid people suffering from 
diabetes. It detects glucose levels in the body, using a tiny electrode called glucose sensor placed under the skin and 
relays the information via Radio Frequency to a monitoring device. 
 
1.3.2 Smart City: 
 
Most cars on the streets go around and round the same block, in search of parking spots. That’s the main reason for 
traffic congestion in the city. Thus, sensors are installed at all the parking spots around the city. These sensors pass the 
occupancy status of each spot to the cloud. Any number of applications can consume that data. It can guide the drivers 
through the shortest route to an open spot. 
 
1.3.3 Industrial Automation: 
 
Industrial automation is one of the most profound applications of IoT. With help of internet of things infrastructure 
backed with advanced sensor networks, wireless connectivity, innovative hardware and machine-to-machine 
communication, conventional automation process of industries will transform completely. Automation completely 
reduces the need for manual checking of various process parameters. 
 
1.3.4 Smart Home: 
 
Smart Home has become the revolutionary ladder of success in the residential spaces and it is predicted Smart homes 
will become as common as smartphones. With IoT we could switch on air conditioning before reaching home or switch 
off lights even after you have left home or can unlock the doors to friends for temporary access even when you are not 
at home. Smart Home products are promised to save time, energy and money. 
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II. THE PROPOSED SYSTEM REQUIREMENTS 
 
This project has been implemented with the motive of to maintain the nature of the plants by continuously monitoring 
the parameters leading to increased life of plants. The project deals with the automated temperature and humidity 
control and all the sensors used are available in the market. The different sensors are being used to maintain the nature 
of the plants. The system will continuously monitor the temperature condition of the room and the data can be 
monitored at anytime and anywhere from the Internet. A Mobile Application is developed and the data are stored in the 
database. An alert or notification is send to the user if the water level in the tank is low. 
 

III. PROPOSED SYSTEM HARDWAE ARCHITECTURE 
 
It usually consists of a central microcontroller to which other objects are connected. The smart garden consists of 
NodeMCU as a hub to which different types of sensors such as moisture sensor, humidity sensor, temperature sensor 
and ultrasonic sensor are connected. The ultrasonic sensor is connected to a water tank which indicated the level of 
water in the tank. Other sensors are connected to their respective positions and these sensors send the data to 
NodeMCU which consists of an inbuilt Wi-Fi technology. 
 
Android application is developed using android studio software. Within the software, the connectivity between the 
application and firebase will be made. So, the user can monitor the parameters from anywhere. 
 
Watering of garden varies with the type of soil. Hence the values of the sensors are predetermined for automation 
purposes inside the software. Whenever the user finds need of watering the garden, a switch in the application will 
automate the process. This helps in complete maintenance of the garden. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 3.1 Block Diagram for the proposed System 
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Fig 3.2 Flowchart of the proposed System 3.3 Advantages of the proposed System: 
 

• The system will continuously monitor the temperature condition of the room and the data can be 
monitored at anytime and anywhere from the Internet. 

 
• The System monitors the water level in the tank. If the water level is low it sends an alert notification to 

the user. 
 

• If the water level in tank is reduced to a minimum value then the motor switch is turned on 
automatically to the water level of the tank reaches the maximum value. 

 
• The results show that the proposed system has good feasibility. It reduces the cost of monitoring system 

at the same time 
 

• Its continuously monitor the moisture content in the soil. 
 

• Its continuously checks the water level in the soil. 
 
 

IV. SYSTEM SOFTWARE ARCHITECTURE 
 
4.2.1 Ubidots 
 
Ubidots is an Internet of Things (IoT) data analytics and visualization company. Ubidots turn sensor data into 
information that matters for business-decisions, machine-to-machine interactions, educational research, and increase 
economization of global resources. Ubidots exists as an easy and affordable means to integrate the power of the IoT 
into your business or research. Ubidots technology and engineering stack was developed to deliver a secure, white-
glove experience for our users. Device friendly APIs (accessed over HTTP/MQTT/TCP/UDP protocols) provide a 
simple and secure connection for sending and retrieving data to and from our cloud service in real-time. 
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Ubidots time-series backend services are performance optimized for IoT data storage, computation and retrieval. Its 
application enablement platform supports interactive, real-time data visualization(widgets) and an IoT App Builder that 
allows developers to extend the platform with their own HTML/JS code for private customization when desired. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                      Figure 4.8 Ubidots platform 4.2.2. Android Studio: 

 
Android Studio is the official Integrated Development Environment (IDE) for Android app development, based on 

IntelliJ IDEA . On top of IntelliJ's powerful code editor and developer tools, Android Studio offers even more features 
that enhance your productivity when building Android apps, such as: 

• A flexible Gradle-based build system 
• A fast and feature-rich emulator 

 
• Instant Run to push changes to your running app without building a new APK 

 
• Code templates and GitHub integration to help you build common app features and import sample code 
• Extensive testing tools and frameworks 

 
• Lint tools to catch performance, usability, version compatibility, and other problems 
• C++ and NDK support 

 
• Built-in support for Google Cloud Platform, making it easy to integrate Google Cloud Messaging and App 

Engine. 
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Fig 4.9 Android Studio IDE 
 
 

V. SIMULATION, IMPLEMENTATION AND TESTING 
 
5.1 Overview: 
 
The proposed system incorporates both hardware and software implementation. The Hardware implementation consists 
of the Arduino Atmega328, DHT11 Humidity and Temperature Sensor, Rain Sensor, Ultrasonic Sensor, Soil moisture 
Sensor, WI-FI module ESP8266. 
 
The Software implementation consists of both the android app and web page. Javascript is used as a scripting language 
to display the output in a webpage. 
 
5.2 Hardware implementation: 
 
The hardware implementation requires an Arduino Mega. The humidity and temperature sensor, rain sensor, soil 
moisture sensor, ultrasonic sensor is connected with the arduino mega. The soil sensor used to measure the water 
content in the soil. The humidity and the temperature sensor continuously monitor the temperature. The ultrasonic 
sensor monitor the water level in the tank. 
 
Programming the Arduino Uno: 
 
STEP 1: Install Arduino IDE software in windows operating system. 
 
STEP 2: Open Arduino IDE and create a new sketch from File menu. 
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1. Figure 5.1 Creating a new Arduino Sketch 
 
STEP 3: Select Arduino board type which is Arduino mega. Tools -> Board -> Arduino/Genuino mega 
STEP 4: Select the Port to which the Arduino is connected 
which is COM4. 
Tools -> Port -> COM4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.2 Selecting the Port 
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STEP 5: Insert the code. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.3 code for sensors 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.4: Code for WiFi Module 
 
STEP 6: Use Upload option to upload the code to Arduino 
Board. 
Sketch -> Upload 
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Figure 5.5: Uploading the code to Arduino 
 

5.3 Software Implementation: 
 
The software implementation provides the creation of API. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 5.6 first page  
 Figure 5.8 information page 
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Figure 5.9 ubidots demopage 
 
 

Figure 5.7 login page 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 

 
 
 

Figure 5.10 Ubidots event page Figure 5.11 Ubidots device page 
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VI. CONCLUSION 
 
The implementation of IoT based smart garden has been verified to satisfactorily work by connecting different 
parameters of the soil to the cloud and was successfully controlled remotely through a mobile application and web 
page. The system designed not only monitors the sensor data, like moisture, humidity, temperature and ultrasonic but 
also actuates other parameters according to the requirement, for example, if the water level in tank is reduced to a 
minimum value then the motor switch is turned on automatically to the water level of the tank reaches the maximum 
value. 
 
The initial cost and the installation of this system are cheap and hence it can be implemented anywhere. With the 
development of sensor technology, the system can be elevated to the next level which helps the users to utilize their 
investment in an economic manner. If soil nutrient sensors can be installed, then the system can be modified to supply 
fertilizers to the garden precisely. This system saves manpower and efficiently utilizes the water resources available 
ultimately leading to more profit. The feedback provided by the system will improve the implementation of the 
gardening process. 
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